IBM Leads
Version 9 Release 1
October 25, 2013

User Guide

IBM
Note

Before using this information and the product it supports, read the information in “Notices” on page 35.
## Contents

### Chapter 1. Get started with Leads  . . .  1
- Inbound channels ...................... 2
- Lead delegates ...................... 2
- Leadbox capacity ...................  2
- Attachments .......................... 2
  - Attachment definitions ............. 2
- Lead filters ........................  3
- Lead Statistics Graphs .............. 3
- Lead Statistics details list .......... 4
- Leads section of the home page ..... 4
- Lead Detail page .................... 7
- Substatus ............................ 9
  - View and set a lead’s substatus .... 10
  - Viewing a lead’s substatus history . 10
  - Setting a lead’s Substatus from the Lead Detail page . . 10
  - Setting a lead’s substatus from the Leads Listing page ... 11

### Chapter 2. Manage Referrals  . . . .  13
- Referral Entry page .................. 13
- Create a referral on behalf of another user . . 13
  - Adding the Lead’s **Originator Reference** field to the Referral Entry page . . 14
- Referral Statistics graphs ........... 14
- Referral Statistics details list ....... 15

### Chapter 3. The Search feature. . . . .  17
- Search results ........................ 17
- Searching leads by using Quick Lead Find page . . 17
- Specifying the criteria by using the Advanced Lead Find table . . 17
- Quick Lead Find page ................ 18
- Advanced Lead Find page ............ 19
- Adding attributes to the Advanced Find page .... 20
- Finding delegated leads ............. 20
- Searching on substatus ............. 21

### Chapter 4. Leads User Interface  . . .  23
- Reorganize your list layout .......... 25
- Campaigns section of the Home page . 26
- Direct Reports section of the Home page . 27
- Territory section of the home page . 28
- Organizations section of the home page . 29
- Referrals section of the Home page .... 30
- Change Requests I Initiated section of the home page .... 31

### Before you contact IBM technical support  . . . .  33

### Notices  . . . . . . . . . .  35
- Trademarks .......................... 37
- Privacy Policy and Terms of Use Considerations . . 37

© Copyright IBM Corp. 1999, 2013
Chapter 1. Get started with Leads

Leads are potential sales opportunities that come from campaign responses, inbound calls, web inquiries, and other marketing channels.

In IBM® Leads, you work with two types of leads:
• General leads, which you create from the Leads Details page or import into the system.
• Referral leads, which are leads created from the Referral Entry page.

Home page

Your home page is your entry point for managing your leads. The page is divided into sections. In each section, you can review summary information and complete the most common tasks.

The sections on your home page can vary depending on your permissions and the way your Leads installation is configured. Typical sections are as follows:
• Campaigns
• Leads
• Leads Statistics
• Referrals I Generated
• Referral Statistics
• Direct Reports (if you are a manager)
• My Organizations (if you are a manager)
• Change Requests I Initiated
• Change Requests For Approval

The Leads user interface

Administrators can customize many of the features in Leads, so the descriptions in this documentation cannot exactly match what you see in your installation of Leads.

Also, the permissions you have in Leads determine the actions you can perform and the interface features you can access. If you can perform a task that is described in the guide, but you do not see the appropriate menu items and fields, see your system administrator.

For more details on working with Leads, see chapter About the Leads User Interface.

To customize many of the features in Leads, you must create tables, attributes, and rules. See the IBM Leads Administrator’s Guide for information about these tasks.
Inbound channels

The inbound channel is the source of a lead. For example, the inbound channel for a lead can be an email message, website visit, or phone call.

The following inbound channel types are set up by default:
- BRC - Business Reply Card
- Call Center
- Email
- Web

Your organization can change or add to these options.

Lead delegates

A lead delegate is a user who can work with another user's leads. If you have a delegate, all of your leads are available to your delegate. Delegates can complete any actions on another user's leads for which they have permissions. These actions are recorded in the lead history as if the lead owner performed them.

To set a lead delegate, go to the User Details page and in the Delegate section, then search for and select one or more users. You can set lead delegate for your own account, or, if you have appropriate permissions, for another user account.

The user that is designated as a delegate can view the delegated leads by choosing Find > Delegated Items. For details, see To find delegated leads.

Leadbox capacity

Leadbox capacity is the ability to control the maximum number of leads that can be assigned to a user. If a user is assigned the maximum number of leads, the leadbox capacity prevents more leads from being routed to that user.

Attachments

You can add attachments to a lead to provide the recipient with more information about the opportunity. For example, you might provide a product brochure or a discount flyer for the sales person to send.

To add an attachment to the system, click New > Attachment. To update an attachment, click View > Attachments and click the name of the attachment you want to update.

To associate an attachment with a lead, you must set up an attachment table and a rule that associates the attachment to leads with specified criteria. Depending on your permissions in the system, ask your system administrator to complete the tasks. For more information about tables and rules, see the IBM Leads Administrator’s Guide.

Attachment definitions

When you create or update attachment definitions, you must enter information such as Name, URL, Local File, Type, and Description.
The following table shows fields that must be filled when you create or update an attachment definition:

**Table 1. Attachment definitions**

<table>
<thead>
<tr>
<th>Attachment Definition</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that you specify for the attachment can follow any convention. For example, the name of the attachment definition can reflect: the name of the actual file; an association with a campaign or promotion; a timeframe, a state, or possibly a territory in which the attachment is valid.</td>
</tr>
<tr>
<td>URL</td>
<td>If you want to notify the lead recipient of a particular website or a particular document on a website, check the selection button and then enter the appropriate URL in this field.</td>
</tr>
<tr>
<td>Local File</td>
<td>This list identifies all the files that are stored in the install_directory/asp/attachments directory. Any file that you want to specify as an attachment must be moved into this directory to be available for use.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of attachment, as defined by your administrator, that is being delivered with the lead. For example, options might include: Discount or Promotion, Leasing Agreement, Product Literature, Order Form, and Training Information.</td>
</tr>
<tr>
<td>Description</td>
<td>Any additional information about the attachment. The information that you enter here is displayed in the Description column on the Attachments list page.</td>
</tr>
</tbody>
</table>

**Lead filters**

You can select a group of leads to view and work with based on criteria you specify.

There are two types of lead filters:
- Pre-defined filters, which are shown in the View drop-down list in the Leads section on the home page.
- Use advanced filters to define a query by using a query builder table and add it to the options shown in the View drop-down list.

The My Lead Filters page lists the custom filters that are currently defined. With the help of it, you can build new filters. To access the page, from the Leads list pages click the Edit view menu icon next to the View drop-down list.

**Lead Statistics Graphs**

The Lead Statistics section on the home page displays statistics about your leads, which are filtered by status. Use the Lead Status drop-down list to select the status by which you want to filter leads.

The following table describes the graphs that you see when you select each of the status options.
Table 2. Graph status

<table>
<thead>
<tr>
<th>Status</th>
<th>Graph Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>This graph displays the total number of active leads (the sum of waiting, accepted, and up-for-grabs leads) and separate totals for waiting, accepted, up for grabs, and rejected leads.</td>
</tr>
<tr>
<td>Active Summary</td>
<td>This graph displays separate totals for waiting, accepted, up for grabs, and rejected leads.</td>
</tr>
<tr>
<td>Accepted</td>
<td>This graph displays the total number of accepted leads and separate totals for the number in each of the substatus categories.</td>
</tr>
<tr>
<td></td>
<td>• No substatus</td>
</tr>
<tr>
<td></td>
<td>• Called, left message</td>
</tr>
<tr>
<td></td>
<td>• Called, presented</td>
</tr>
<tr>
<td></td>
<td>• Actively selling</td>
</tr>
<tr>
<td></td>
<td>• Verbal commitment</td>
</tr>
<tr>
<td></td>
<td>• P.O. in progress</td>
</tr>
<tr>
<td>Waiting</td>
<td>This graph displays the total number of waiting leads and separate totals for assigned, copied, and up-for-grabs leads.</td>
</tr>
<tr>
<td>Closed</td>
<td>This graph displays the total number of closed leads and separate totals for the number of leads that are won and lost.</td>
</tr>
<tr>
<td>CC’d</td>
<td>This graph displays the total number leads that were copied to another person.</td>
</tr>
</tbody>
</table>

Lead Statistics details list

When you click any bar on the Lead Statistics bar graph, a window opens showing the list of leads. All the leads in the list have the status that you select.

The columns of information and command buttons you see on the list page depend on the Lead Status you selected in the Lead Statistics section on your home page, and the column you selected on in the Lead Statistics bar graph.

You can complete the following tasks on the Lead Statistics details page:
• View summary information about each lead.
• Click underlined item in the table to view more details about it.
• Use the command buttons at the top of the table to act on leads that are selected in the table.

Leads section of the home page

Leads section on the home page consists of command buttons with which you can initiate and complete various tasks.

In addition to the common command buttons, the following information and commands are available in the Leads section of the home page.
Summary information in the Leads section of the home page

The Leads list displays the following information about your leads.

Table 3. Field name and description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Role</td>
<td>The Lead's delivery status.</td>
</tr>
<tr>
<td></td>
<td>- The lead is assigned to you.</td>
</tr>
<tr>
<td></td>
<td>- The lead is tagged.</td>
</tr>
<tr>
<td></td>
<td>- The lead was forwarded to you.</td>
</tr>
<tr>
<td></td>
<td>- The lead is &quot;up for grabs.&quot;</td>
</tr>
<tr>
<td></td>
<td>- The lead was sent to you as a copy.</td>
</tr>
<tr>
<td></td>
<td>- The lead has one or more attachments.</td>
</tr>
<tr>
<td></td>
<td>- The lead is closed.</td>
</tr>
<tr>
<td>Opportunity</td>
<td>The name that is identifying the lead. This name was assigned to the lead</td>
</tr>
<tr>
<td></td>
<td>when it was created.</td>
</tr>
<tr>
<td>Company</td>
<td>The name of the company where the contact works.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the primary contact for this lead.</td>
</tr>
<tr>
<td>Product</td>
<td>The product that is being sold in this lead.</td>
</tr>
<tr>
<td>Date Entered</td>
<td>The date the lead was created.</td>
</tr>
<tr>
<td>Date Last Modified</td>
<td>The most recent date when information about the lead was changed.</td>
</tr>
<tr>
<td>Status</td>
<td>The lead status: Accepted, Closed, Rejected, or Waiting.</td>
</tr>
<tr>
<td>Lead's Lead Type</td>
<td>Whether the lead is of the General or Referral type.</td>
</tr>
<tr>
<td>Suggested</td>
<td></td>
</tr>
<tr>
<td>Assignment</td>
<td>The sales representative who assigned this lead.</td>
</tr>
</tbody>
</table>

Command buttons in the Leads section of the home page

The following table describes the command buttons that are unique to leads.

Table 4. Command buttons in the Leads section of the home page

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Find leads</td>
<td>Click the button to display the Find Leads page. You can use this page to define a query to locate specific leads.</td>
</tr>
<tr>
<td></td>
<td>Accept leads</td>
<td>Select one or more leads, and click this button to accept the selected leads. Accept a waiting lead if you plan on contacting the customer to try to make a sale.</td>
</tr>
</tbody>
</table>
Table 4. Command buttons in the Leads section of the home page (continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Reject leads</td>
<td>Select one or more leads, and click this button to reject the selected leads. Reject a lead if, after you review the lead, you decide that any additional effort is not result in making a sale.</td>
</tr>
<tr>
<td></td>
<td>Tag leads</td>
<td>Select one or more leads, and click this button to tag the selected leads.</td>
</tr>
<tr>
<td></td>
<td>Close leads</td>
<td>Select one or more leads, and click this button when you take no more action on the selected leads. Mark the closed leads Won or Lost.</td>
</tr>
<tr>
<td></td>
<td>Put leads Up For Grabs</td>
<td>Select one or more leads, and click this button to put the selected leads up for grabs to other users. When you put a lead up for grabs, you own the lead until another user accepts the lead.</td>
</tr>
<tr>
<td></td>
<td>Send a copy of selected leads</td>
<td>Select one or more leads, and click this button to send a copy of the leads to another user. The person who is receiving the copy of the lead does not become the owner of the lead; you still own it.</td>
</tr>
<tr>
<td></td>
<td>Forward leads</td>
<td>Select one or more leads, and click this button to forward the checked leads to a particular person. When you forward a lead, you no longer own it; the lead is owned by the person who is receiving it.</td>
</tr>
<tr>
<td></td>
<td>Forward leads to Suggested Assignment</td>
<td>Select one or more leads, and click this button to route the selected leads to the person or routing group that is listed in the Suggested Assignment column. When you forward a lead, you no longer own it; the lead is owned by the person who is receiving it.</td>
</tr>
<tr>
<td></td>
<td>Automatic Forward to Suggested Assignment</td>
<td>Click this button to automatically route all leads that have a person or routing group that is listed in the Suggested Assignment column. Do not select the leads before you click this button. When you forward a lead, you no longer own it; the lead is owned by the person who is receiving it.</td>
</tr>
<tr>
<td></td>
<td>Update Suggested Assignments</td>
<td>Refresh the suggested assignments for the leads in this leadbox by running the rules that assign users for these leads.</td>
</tr>
<tr>
<td></td>
<td>View Attachments</td>
<td>Select one or more leads, and click this button to view attachments that are added to the lead. You use an attachment table to associate an attachment definition with leads that have a particular set of attributes.</td>
</tr>
<tr>
<td></td>
<td>View Lead History</td>
<td>Select one or more leads, and click this button to view the lead’s history information.</td>
</tr>
<tr>
<td></td>
<td>Print</td>
<td>Print detailed information for the selected leads.</td>
</tr>
</tbody>
</table>
Lead Detail page

To create a general lead, you enter the information about the business opportunity on the Lead Details page. The fields that define a lead might be customized by your organization. Required fields are marked by a red asterisk (*) following the name of the field. You cannot save a lead if you do not complete mandatory fields.

**Note:** Although some fields are optional, the lead is complete and useful if you populate as many fields as possible. You can use the values in lead details fields as criteria in rules (for routing and managing leads).

The following tables describe the default sections and fields on the Lead Details page.

**Sections on the Lead Details page**

The following table shows sections on the Lead Details page and its description.

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead</td>
<td>Basic information that is identifying the lead.</td>
</tr>
<tr>
<td>Contact</td>
<td>The person to contact at the customer site.</td>
</tr>
<tr>
<td>Opportunity</td>
<td>Detailed information about the business context for the lead.</td>
</tr>
<tr>
<td>Routing and Tracking</td>
<td>How the lead is managed.</td>
</tr>
<tr>
<td>Notes</td>
<td>A field that you can use to record any other information about the lead.</td>
</tr>
</tbody>
</table>

**Lead section**

The following table shows the fields in the Lead section with its description.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Lead's Originator</td>
<td>The creator of the lead. Leave the default to set yourself as the originator of the lead, or select another user.</td>
</tr>
<tr>
<td>Opportunity</td>
<td>The name of the lead. Enter a descriptive phrase that identifies the lead to other users. The text that you enter in this field is displayed where ever leads are listed.</td>
</tr>
<tr>
<td>Product</td>
<td>The product or service in which the customer is interested.</td>
</tr>
<tr>
<td>Company</td>
<td>The customer's company.</td>
</tr>
</tbody>
</table>

**Contact section**

The following table shows field in the Contact section with its description.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contact</td>
<td>The person to contact at the customer site.</td>
</tr>
</tbody>
</table>
Opportunity section

The following table shows the fields in the Opportunity section with its description.

Table 8. Field names in the Opportunity section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Campaign</td>
<td>The marketing program or initiative that generated this lead.</td>
</tr>
<tr>
<td>Inbound Channel</td>
<td>The method by which the lead came into your organization, such as through a call center.</td>
</tr>
<tr>
<td>Buyer Type</td>
<td>The contact’s purchasing responsibilities. For example, the contact can recommend only products, or approve purchases.</td>
</tr>
<tr>
<td>Customer Type</td>
<td>More information about the type of lead.</td>
</tr>
<tr>
<td>Opportunity Size</td>
<td>The potential sale amount. If you choose to provide this information, you must enter a numeric value that is representing a dollar amount. You can enter as many as 15 digits.</td>
</tr>
<tr>
<td>Approved Budget</td>
<td>The approved budget. Knowing both the size of the opportunity and the approved budget determines whether the lead is worth follow-up.</td>
</tr>
<tr>
<td>Time to Buy</td>
<td>The time frame in which the potential customer plans to buy a product.</td>
</tr>
<tr>
<td>Closure Probability</td>
<td>The likelihood of making a sale.</td>
</tr>
<tr>
<td>Competitors</td>
<td>Any known corporate competitors.</td>
</tr>
<tr>
<td>Lead’s Rank</td>
<td>The rank of the lead. Options include Hot, Warm, Cold, or Unqualified.</td>
</tr>
<tr>
<td>Lead’s Score</td>
<td>Whether the lead is Qualified as a confirmed lead, or Unqualified. Unqualified means that the customer’s willingness and ability to buy is uncertain. This field is automatically populated if a &quot;prioritize by using a weighted average&quot; rule processes this lead.</td>
</tr>
<tr>
<td>Is In Overflow</td>
<td>This check box is set if the lead was processed by the Lead Capacity feature and was not delivered because the destination leadbox reached the specified &quot;limit.&quot; Do not set this field manually.</td>
</tr>
</tbody>
</table>

Routing and tracking section

The values in company-related fields correspond to the company where the contact is employed.

The following table shows fields in the Routing and Tracking section:

Table 9. Field names in the Routing and tracking section

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preferred Reseller</td>
<td>The organization that must assume responsibility for the lead. This can be a subdivision or department in your company, or an external channel partner.</td>
</tr>
<tr>
<td>Preferred Representative</td>
<td>The person who must assume responsibility for this lead.</td>
</tr>
<tr>
<td>Tagged</td>
<td>A flag that can be used to track and filter leads. You can tag leads for any purpose. The tag can be used to track particular leads.</td>
</tr>
</tbody>
</table>
Notes® section

Any information about the lead that might be useful to yourself or others.

Command buttons on the Lead Details page

If you are assigned the lead or have the appropriate permissions, you can use the command buttons on the Lead Details page to act on the lead. By default, the following command buttons are available as shown in the table.

Table 10. Command buttons on the Lead Details page

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Accept Lead" /></td>
<td>Accept Lead</td>
<td>Click to accept the Waiting lead that is assigned to you. Accept a lead if you plan on contacting the customer to try to make a sale.</td>
</tr>
<tr>
<td><img src="image" alt="Reject Lead" /></td>
<td>Reject Lead</td>
<td>Click to reject a Waiting lead that is assigned to you. Reject a lead if, after you review the lead, you decide that any additional effort is not result in making a sale, and you do not want to work the lead.</td>
</tr>
<tr>
<td><img src="image" alt="Close Lead" /></td>
<td>Close Lead</td>
<td>Click to take no more action on the lead. When you close a lead, you mark the lead as Won or Lost and supply more information.</td>
</tr>
<tr>
<td><img src="image" alt="Forward Lead" /></td>
<td>Forward Lead</td>
<td>Click to forward the lead to another person. When you forward a lead, you no longer own it; the lead is owned by the person to whom you forwarded it.</td>
</tr>
<tr>
<td><img src="image" alt="View Lead History" /></td>
<td>View Lead History</td>
<td>Click to view all the actions that are taken on a lead, including the time and user. Lead history includes the lead’s creation time, the lead’s originator, and the method by which you received the lead. In addition, it includes detailed information about rules that processed the lead. <strong>Note:</strong> If the lead’s originator is changed after the lead is created, the record of the first originator is not reflected in the lead’s history.</td>
</tr>
</tbody>
</table>

Substatus

A substatus provides details of activities that are related to the particular lead. Only leads in the Accepted state can have a substatus.

Following activities are included in Substatus:

- Called, left message
- Called, presented
- Actively selling
- Verbal commitment

There is a default that is set of possible sub-status values. The system administrator can modify the list if required. The system administrator can also allow users to enter any text for the sub-status value. Users can also add a note to explain the sub-status value.
If the administrator added it, you can find the Substatus History section in the Lead Details page. You can also set how many rows of the history are shown per page.

All sub-status values are preserved in the sub-status history, along with the dates and times they were set and any notes included with the changes.

**Note:** Any substatus value change is saved with the lead, even if you do not save the lead itself. Therefore, every sub-status value is stored in the sub-status history regardless of other lead changes. Changes to a lead’s substatus are also recorded in the lead’s history.

**View and set a lead’s substatus**

An accepted lead's substatus is listed in the Leads Detail page, in the Opportunity section. Users can set a new substatus value from this field.

You also have the option of making accepted leads’ substatus values viewable and editable from the Leads Listing page. To enable this option, you must configure the Leads Listing page to show the substatus.

**Viewing a lead’s substatus history**

You can view the complete substatus history for a lead from the Lead Details page. All substatus values set for the lead are saved in the history, even when the lead itself is not saved.

Complete the following steps to view a lead’s substatus history:

1. Open the Lead Details page.
2. Expand the Substatus History section.
   - You can change the number of rows that are shown together in the history table by clicking the **Configure view** icon.
   - If there are more records than can be shown together, use the **Page** field and the **Next** icon to view more records.

**Setting a lead’s Substatus from the Lead Detail page**

If a lead is Assigned, you can set the lead’s substatus from the Lead Detail page one or more times as you work the lead. Each sub-status change you make is saved in the Substatus History.

**Note:** If the lead is not in Assigned state, the substatus field is read-only.

Complete the following steps to set a leads substatus from the Lead Detail page:

1. Open the Lead Detail page for the lead.
2. Expand the Opportunity section.
3. In the Opportunity section, next to the **Sub-status** field, click the **Edit Sub-status** icon.
   - The Set Substatus dialog box opens.
4. Select a substatus value from the drop-down list.
5. Add a note that further explains the sub-status change.
6. Click **OK**.
The new substatus value is added to the Substatus History. This value is saved in the Sub-status History even if you do not save the lead changes. To view Substatus History, expand that section of the Lead Details page.

**Setting a lead's substatus from the Leads Listing page**

If an administrator adds the Substatus column to the Lead Listing page and the lead is **Assigned**, you can set the lead’s substatus without opening the lead. Each substatus change you make is saved in the substatus history.

**Note:** If the lead is not in Assigned state, the substatus field is read-only.

Complete the following steps to set a lead's substatus:

1. Open the Leads Listing page.
2. In the Substatus column, click the substatus value for the lead.
   
   The Set Substatus dialog box opens.
3. Select a substatus value from the drop-down list.
4. Add a note that further explains the substatus change if required.
5. Click **OK**.

The new substatus value is associated with the lead and is added to the lead’s substatus history.
Chapter 2. Manage Referrals

A referral is a lead that any user can create as per the requirement. To create a referral, complete the minimal information about the product, contact person, and an optional message. The system creates one or more new leads with Waiting status.

When you click a lead that is generated by a referral, a Lead Details page opens with all the usual fields, and information can be added as the lead is worked. When you submit a new referral, a separate lead is created for each product you selected. The leads are automatically assigned to a recipient according to the rules set up for your organization.

Referral Entry page

Referral Entry page consists of several fields that must be entered by user at the time of creating referral.

Following table shows the fields on Referral Entry page with its description.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Customer/Contact Name | Enter the contact name for the customer requesting this referral:  
  * If the referral is for a current customer, click the Find icon to search for the name in the system.  
  * If the referral is for a new customer, click the New icon to create a new Contact record.  
  * If you want to clear the name of a contact you entered from the field, click the Eraser icon.  |
| Products            | Click Find to search for the name of the product or products that interests the customer. The application enters your selection from the list of find results in this field.  
  To remove a product from the Referral Form list, select it, and click the Eraser icon. |
| Lead's Originator Reference | Enter an originator for the referral. The Originator Reference field is required if it is displayed on the referral page.  
  The Originator Reference field defaults to the current user. Change the Originator Reference field to create a referral on behalf of another user. |
| Message for Recipients | Enter any information you want to send to recipients of the referral lead. This message is a part of the lead notification that is distributed to the recipient who is assigned this referral lead. |

Create a referral on behalf of another user

If the Lead's Originator Reference field is visible on the Referral Entry page, you can create a referral on behalf of another user. To create a referral on behalf of another user, you must select the other user for the Lead's Originator Reference field when you create the referral. You cannot change this field after the referral is saved.

Referrals that are created on behalf of other users are displayed in the Referrals I Generated list of the new Lead Originator’s home page. Users have the same
permissions that regard to Lead Originator as they do for other users. For example, if a user can create and delete users, the user can create and delete Lead Originators.

Adding the Lead's Originator Reference field to the Referral Entry page

Use Detail Page Editor page to add the Lead’s Originator Reference field to the Referral Entry page.

Complete the following steps to add the Lead’s Originator Reference field to the Referral Entry page:

1. Click Configure > Detail Pages.
   The Detail Page Editor page opens.
2. Click Referral Entry.
   The Detail Page Editor for Referral Entry page opens.
3. Click the Add Field button in the Basics section.
   The Add Field page opens.
4. Complete the fields as follows and then click OK.
   • Available Fields: Select Lead's Originator Reference.
   • Display As: Select Text Field.
   • Insert: Select where you want the field to be displayed.
5. Click File > Save and Publish.
   When you return to the Referral Entry page, the Lead's Originator Reference field is displayed.

Referral Statistics graphs

The Referral Statistics section on the Home page displays statistics about the referrals that you generate, filtered by status. Use the Referral Status drop-down list to select the status by which you want to filter the referrals.

You can filter the referrals by their status. Status can be Active, Accepted Leads, or Closed Leads.

Referral Statistics graphs

The following table describes the graphs that you see when you select each of the status options.
Table 12. Status and Graph description

<table>
<thead>
<tr>
<th>Status</th>
<th>Graph Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>This graph displays the total number of referral leads you generated that are currently active. A referral lead is active if it is not closed. The graph shows the number of referral leads in each of the states that an active lead can have, as follows.</td>
</tr>
<tr>
<td></td>
<td>• Waiting, assigned: These referrals are assigned, but the recipient that is not yet indicated about working on it.</td>
</tr>
<tr>
<td></td>
<td>• Accepted: These referrals are accepted by a recipient who agrees to work on the referral.</td>
</tr>
<tr>
<td></td>
<td>• Rejected: This status means the recipient of the referral cannot work the referral lead. Depending on the rules your organization, the referral might be assigned to another recipient.</td>
</tr>
<tr>
<td></td>
<td>• Up for grabs to multiple recipients: The referral is made available to a group of recipients, any one of whom might accept the referral. When a referral is in this state, you do not yet know who is working on your referral. When one of the groups accepts the referral lead, the status changes to Accepted.</td>
</tr>
<tr>
<td>Accepted Leads</td>
<td>This graph displays the total number of referral leads you generate with separate totals for the number in each of the substatus categories. The substatus is set by the recipients as they work on the referral to indicate where the referral lead is in the selling process.</td>
</tr>
<tr>
<td></td>
<td>• No substatus</td>
</tr>
<tr>
<td></td>
<td>• Called, left message</td>
</tr>
<tr>
<td></td>
<td>• Called, presented</td>
</tr>
<tr>
<td></td>
<td>• Actively selling</td>
</tr>
<tr>
<td></td>
<td>• Verbal commitment</td>
</tr>
<tr>
<td></td>
<td>• P.O. in progress</td>
</tr>
<tr>
<td>Closed Leads</td>
<td>This graph displays the total number of leads that are created by a referral from you that are closed. A referral lead can be closed because it was successful or because the referral lead is not successful and is no longer being worked. These leads are &quot;lost.&quot; The graph shows separate totals for the number of referral leads won and lost.</td>
</tr>
</tbody>
</table>

Referral Statistics details list

When you click a bar in a Referral Statistics graph, a window lists the referral leads that have the status that you select. The columns of information and command buttons you see on the list page depend on the Referral Status you selected in the Referral Statistics section, and the column you select in the Referral Statistics bar graph.

You can use the page to do the following tasks:
• View summary information about each referral lead.
• Click underlined item in the table to view more details about it.
• Use the command buttons at the top of the table to act on referral leads selected in the table.
Chapter 3. The Search feature

Use search feature to obtain list of active leads or to find referrals by specifying the search criteria. You can use search feature for many objects as you work with IBM Leads.

Typical uses of the search feature are as follows:
- To narrow the list of leads you are working with by searching for leads that match criteria you specify.
- When you create general leads and referrals, you can search for products, companies, campaigns, inbound channels, and users.

Throughout the Leads user interface, the **Find** is used to indicate that the search feature is available. When you see **Find** next to a field on a form you are completing, you can click to open the search page for the object that is required to complete that field. When the search results are listed, you can then select from the list and click **OK** to add the selected items to the field.

If you have appropriate permissions, you can also access the search pages for Leads objects by clicking **Find > [object]**.

Search results

If your search finds leads that match your criteria, those leads are listed. If your search does not find leads that match your criteria, no leads are listed.

*Note:* To rerun your query by using different conditions, click **Modify Query** to return to the previous page. Do not use the browser’s **Back** button.

Searching leads by using Quick Lead Find page

Use the options on the Quick Lead Find page to search for leads. The search options are available depending on your user role.

Complete the following steps to search leads by using the Quick Lead Find page:
1. Select the **Find** button in the Leads section of your home page. The Quick Leads Find page opens.
2. Select the criteria that you want the leads to match.
3. Click **Find** to run the search query.

The list of leads meets the criteria that you specified. Only leads that you currently own, formerly owned, or are owned by your direct reports are displayed.

Specifying the criteria by using the Advanced Lead Find table

You can use the Advanced Lead Find table to specify the criteria for searching leads.

Complete the following steps to specify the criteria by using the Advanced Lead Find table:
1. In the Item column, select the component of the lead you want to use as a search filter. You can select Lead, Assignment, Contact, or Company.

2. In the Attributes column, select the attribute of the object that you want to search for. The drop-down list displays the appropriate attributes for the item you select in the first column. If you have appropriate permission, you can configure other attributes and custom attributes to display in the list. For example, you can add Campaign Type to find all leads that are generated by a particular type of campaign.

3. In the Operator column, select the relationship between the attribute you select and the value for which you want to search.

4. In the Value column, select the value of the attribute for which you want to search. If you use the Like expression, you can enter a value by using the percent sign (%) and underscore (_) characters as wildcard. The percent sign matches any sequence of characters, and the underscore character matches any single character. You must enter an underscore for each wildcard character you want to include in the string.

5. Continue to build your query as follows. If you want to add another condition for your search, click the plus (+) button. Repeat steps 1 - 4 for that row.

6. If you want to remove a previously added row, select the check box to the left of the row and click the minus (-) button.

7. In the first column between the rows, select the relationship between the conditions you specify that you want to use in your search check box. For example, you can and or or the results of each row.

8. Before you run your search, select the check box to the left of each row that you want to apply to your search.

Quick Lead Find page

Quick Lead Find page contains fields and buttons you use when you search for a lead on the Quick Lead Find page.

Quick Lead Find page contains following sections:

Find leads section

The following series of criteria phrases are listed, each with its own Find button and the option to further refine the query using the Advanced Lead Find feature.

Before you click the Find button to perform the search, you can select some, none, or all of the additional criteria on both sections of the page to further refine your search.

- Leads I created
- Leads in my inbox
- Leads I tagged
- Leads in leadboxes in my territory
- Leads with attachment
- Leads for contact (with search for user)
- Leads assigned to (with search for user)
- Overflow leads assigned to (with search for user)
- Leads where [option] [is or contains]

The following options are provided.
The following more criteria are available in this section.

- Include leads of the following types—Options are **Include referral leads** and **Include general leads**.
- Show leads created between the following dates—**From** and **To** fields allow you to set a date range.

**Show leads with the following status section**

Checkboxes allow to select some, none, or all of the following options to include in your search criteria.

- accepted
- waiting, assigned
- up for grabs to multiple recipients
- closed
- waiting, up for grabs
- rejected
- cc'd

**Advanced Lead Find page**

Advanced Lead Find page contains fields and buttons you use when you search for a lead on the Advanced Lead Find page. The Advanced Lead Find page also has a query builder where you can select from criteria and operators to refine your search.

The lead-related items from which you can choose are as follows:

- Assignment
- Leads
- Contact
- Company

Many of the item attributes and other criteria that make up your query are provided by the system, which is based on the item you select.
Adding attributes to the Advanced Find page

You can configure attributes, or create custom attributes, and enable their use in tables so they can be displayed in the list. The drop-down list in the Attributes column contains a default list of attributes for the object you select. You must have permissions to create and configure attributes.

Complete the following steps to add attributes to the Advanced Find page:

1. Click Configure > Attributes.
2. Select the object whose attributes you want to add to the Advanced Find page.
   For example, select Campaign.
3. Click the name of the attribute you want to add.
4. In the Find, Rule, Table Access section, select Find for each instance of the attribute you want to add.
5. Click OK.

When the relevant option is selected in the Item column on the Advanced Find page for the relevant object, the attribute you enable is displayed in the Attribute column.

Finding delegated leads

Users can delegate one or more leads to you. You can find out the leads that are assigned to you by using Find Delegated Item page.

Complete the following steps to find delegated leads:

1. Click Find > Delegated Items. The Find Delegated Items page opens.
2. If more than one user delegate leads to you, select the user whose leads you want to find from the Delegated Leads Assigned To list.
3. Select the type of leads you want to find.
   You can choose to include referral leads and general leads.
4. Select the creation dates for which you want to find leads.
   If you want to see only the leads that are created with in a specific range of time, check Show leads created between the following dates. Then, use the From and To fields to set the beginning and end dates of the range you are interested in. To select a date, click the Calendar icon next to the field.
5. Select the statuses of the leads you want to find.
   Check the statuses under Show leads with the following status to see only leads that currently have the statuses you select.
6. Click Find to display the delegated leads that are matching the conditions that you set, or click Cancel to close page without displaying any leads.

The application displays the Find Results page that lists the delegated leads. Take action on the leads in Leads List page, but the action is recorded as if the owner completes the action.
Searching on substatus

If Substatus feature is configured for leads, you can search for leads based on their Substatus value.

Complete the following steps to search lead by using Substatus feature:

1. Click Find > Lead.
   The Quick Lead Find page opens.
2. Click Advanced Find.
   The Advanced Lead Find page opens.
3. Add and populate rows in the table to set criteria for your search.
   To include a sub-status value in the search criteria, do the following in a table row.
   a. In the Item column, select Assignment.
   b. In the Attribute column, select Lead’s Sub-status.
   c. Select an operator.
   d. In the Criteria column, select a sub-status value.
      You can select from values defined as valid for the attribute.
4. Complete other search fields as necessary.
5. Click Find.

Leads are listed that match the search criteria you specified, including the sub-status value.
Chapter 4. Leads User Interface

When you use Leads, you deal with the Leads user interface. A number of controls are common to some or all of the pages of Leads user interface. You can use the controls for customizing the interface as per your requirement.

Sort the list

You can accomplish following tasks in Leads user interface:

By default, the entries on a list page are listed alphabetically by name. An arrow next to the column heading shows which column is being used to sort the list and the direction of the sort: ascending or descending.

You can change the sort order by clicking the heading of a column. The table sorts the list by the entries in that column, in ascending order. For example, if you click the Description column, the list is sorted alphabetically by the first letter of the description. Click the heading again to reverse the sort order.

Display items by letter, number, or other character

To display only the items with names that begin with a selected character, click one of the letters or the numbers in the bar at the top of the table.

For example, if you click 'K', the list displays only the entries with names that are beginning with that letter.

If you click Misc, the list displays only entries that begin with a special character that is not a letter or a number, for example “%”.

Click All to see all the items in the list.

Display items by other criteria

View filters are available in the View drop-down list. View filters display only items that meet specific criteria. The criteria differ depending on the object. For leads, there are two types of filters, pre-defined and custom, which is described in the chapter "Getting Started with Leads." For other objects, you can select only from a set of pre-defined criteria.

To display only the items that match pre-defined or custom criteria, use the View list at the top of the page to select the criteria by which to filter. The list page displays only the items that match those criteria. You can select All from the View list to see all the items again.

For example, when you view the Inbound Channels list, you can choose email from the View list to see only the email channels.

Note: The View list is displayed only if the list contains items that match differing criteria.
Display items page by page

If the list of objects contains too many items to be displayed on one page, a set of navigation controls is displayed:

![Navigation controls]

Click the arrows to move ahead or back by 20 items at a time, or to jump to the first or last page in the set.

Select an item for action

In most lists, you can click the check box next to items to select one or more items for action. Click the check box in the heading row to select all the items.

See more detailed information

Click the underlined items in a list to see more detailed information. For example, on the Leads list page, click the name of the lead in the Opportunity column to see the Lead Details page for that lead.

Common command buttons

The following table describes command buttons that are available for many of the objects you work with in Leads.

Table 13. Command buttons and description

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Find button]</td>
<td>Find [object]</td>
<td>When Find is shown above a list of objects or next to a field, click the button to search for the objects of the same type as listed, or that are required for the field.</td>
</tr>
<tr>
<td>![New button]</td>
<td>New [object]</td>
<td>Open an object details page to create an object.</td>
</tr>
<tr>
<td>![Delete button]</td>
<td>Delete [object]</td>
<td>Delete the selected object. The Delete Summary page opens, showing the effect of removing the object. You can continue to delete the object, or cancel the action.</td>
</tr>
<tr>
<td>![View hierarchy button]</td>
<td>View [object] hierarchy</td>
<td>For objects that can contain other objects, such as Campaigns, Organizations, and Users (which have a reporting hierarchy), you can view either a flat list or a list that reflects the parent-child relationships. When you click View hierarchy, the objects are displayed in tree form, with their child objects nested under them. You can expand or close the parent object to see or hide the objects that it contains.</td>
</tr>
<tr>
<td>![View hierarchy for selected object (pop-up) button]</td>
<td>View [object] hierarchy for selected [object] (pop-up)</td>
<td>When you use the hierarchy view for Campaigns, Organizations, and Users, you can select an item in the list and click the button to open a pop-up window and see the tree for the selected object only.</td>
</tr>
</tbody>
</table>
Table 13. Command buttons and description (continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="View" /></td>
<td>View [object] list</td>
<td>For objects that can contain other objects, such as Campaigns, Organizations, and Users (which have a reporting hierarchy), you can view either a flat list or a list that reflects the parent-child relationships. When you click this button, all of the objects are displayed in a flat list, with the parent-child relationships not shown.</td>
</tr>
<tr>
<td><img src="image" alt="Toggle" /></td>
<td>Toggle tree details</td>
<td>For objects that can contain other objects, such as Campaigns, Organizations, and Users (which have a reporting hierarchy), when you are using the hierarchy view, you can show or hide the detail columns that are shown in the list. Hiding the details allows more room for you to expand the hierarchy and work with items. Click the <strong>Toggle tree details</strong> button to switch between these views.</td>
</tr>
<tr>
<td><img src="image" alt="Configure" /></td>
<td>Configure view (pop-up)</td>
<td>Display the Configure View page. Use the page to add or remove columns of information from the page from which you clicked this button, and reorder the columns that are displayed. You can add a column to display the value of any of the attributes that are defined on the Details page for the object.</td>
</tr>
</tbody>
</table>

Reorganize your list layout

Use **Configure view** to modify the layout of list output. Click the **Configure view** to open a Configure Table window. You can reorganize the layout of list by using controls on this page.

You can change the layout of list in following ways.

**Change columns show in the table**

The configuration window displays two columns that can be used to adjust which columns of information show in the list table.

- The box on the left, **Active Column Headers**, lists the columns that are currently displayed in the window.
- The box on the right, **Available Column Headers**, lists the columns that you can choose to display on the window.

You use the arrows between the boxes to add and remove columns from the window.

- To remove a column from the list page, in the **Active Column Headers** box, select the column that you want to remove and then click the arrow that points to the right.
  
  The header name moves to the **Available Column Headers** box. When you return to the list page, this column is no longer displayed.

- To add a column to the list page, select the header that you want to add from the **Available Column Headers** box and then click the arrow that points to the left.
  
  The header name moves from the **Available Column Headers** box to the **Active Column Headers** box. When you return to the list page, this column is now displayed.
To change the order in which the columns are displayed on the list page, select the header that you want to move. Then, click either the up or down arrow to the left of the column to move the header to the position you want the item to be displayed in relation to the other column headers. Top to bottom on the Configure Table window corresponds to left to right on the list page you are configuring.

**Specify the number of rows**

By default, each configurable list displays up to 10 rows. If more than 10 entries exist in your system, navigation controls that you can use to move from page to page in the list are displayed at the top of the table. Use the Number of Rows to Display in Table option to control how many rows are listed in the table before the paging controls are displayed.

**Display text for icons**

Select Display Text for Action Buttons to add text icon labels for the command buttons on the list window. A text label is displayed below each command button on the list page, explaining the button’s use.

### Campaigns section of the Home page

Campaign section on the home page consists of command buttons with which you can initiate and complete various tasks such as creating new campaign or subcampaign, inserting existing campaign, and so on.

Campaign section contains following information:

**Summary information in the Campaigns section of the Home page**

The following table shows the columns in Campaign section of the Home page:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name that is given to the campaign when it was created.</td>
</tr>
<tr>
<td>Campaign Code</td>
<td>The code the campaign was assigned when it was created. You can use the code field to label the campaign in any way that is useful to your organization.</td>
</tr>
<tr>
<td>Start Date</td>
<td>The date the campaign is scheduled to start. You cannot set a subcampaign to begin before the start date of its parent campaign.</td>
</tr>
<tr>
<td>End Date</td>
<td>The date the campaign is scheduled to end. You cannot set a subcampaign to end later than its parent campaign.</td>
</tr>
</tbody>
</table>

**Drop-down menu commands for Campaigns**

When you are viewing the campaign list as a hierarchy, in addition to the common command buttons, you can click the folder icon next to each campaign name to access a drop-down list with the following commands. You must have permission to change campaigns to access these commands.

The following table shows the drop-down menu commands for Campaigns:
Table 15. Drop-down menu commands

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create new parent campaign</td>
<td>Create a campaign as a parent of the selected campaign. The Campaign Details page opens. When you complete the details page, the new campaign is added to the hierarchy as a parent of the campaign on which you selected the command.</td>
</tr>
<tr>
<td>Create new subcampaign</td>
<td>Create a campaign as a child of the selected campaign. The Campaign Details page opens. When you complete the details page, the new campaign is added as a child of the one on which you selected the command.</td>
</tr>
<tr>
<td>Insert existing subcampaign</td>
<td>Add an existing campaign to the hierarchy as a child of this campaign. The Campaigns list page displays the campaign that you want to add. When you complete the selection, the campaign becomes a subcampaign of the campaign from which you selected the command. The campaign that you add keeps any subcampaigns for which it is the parent. All the items below the selected campaign are moved with it below its new parent campaign.</td>
</tr>
</tbody>
</table>

Direct Reports section of the Home page

Direct Reports section on the home page consists of command buttons with which you can initiate and complete various tasks such as viewing reporting hierarchy of a selected user.

In addition to the common command buttons, the following information and commands are available in the Direct Reports section of the home page.

Summary information in the Direct reports section of the Home page

The following information is displayed in the Direct Reports section of the home page.

Table 16. Column names in the Direct reports section of the Home page

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the user.</td>
</tr>
<tr>
<td>Organization</td>
<td>The organization to which the user belongs.</td>
</tr>
<tr>
<td>Title</td>
<td>The title of the user.</td>
</tr>
<tr>
<td>Role</td>
<td>The role of the user.</td>
</tr>
</tbody>
</table>

Reporting hierarchy command button for Direct Reports

The following table contains information about Reporting hierarchy command button along with its description:

Table 17. Reporting hierarchy command button

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Button" /></td>
<td>You can click the View reporting hierarchy for selected user button to view the reporting hierarchy for a selected user in a pop-up window.</td>
</tr>
</tbody>
</table>
Territory section of the home page

The Territory section of the home page lists the users in your territory. Your territory is made up of all the users in your organizational hierarchy that are related to you through the reporting structure or through your organizations.

For example, your direct reports, users who report to your direct reports, users in organizations you manage and in the organizations those users manage.

The tree view of your territory

Users in your territory are displayed in two different hierarchies:

- Direct Reports: This hierarchy lists the users that you manage, as defined in the system. Users that also have other users that are reporting to them are marked by the is manager icon 🧵. Click + next to the icon to see the user's Direct Reports. Click the underlined name of a user to see the User Details page for that user.

- Managed Organizations: This hierarchy lists the organizations that you manage. Click + next to the organization's folder icon to see the users in the organization. If the users also manage organizations, there is a folder for their organizations. You can again click + next to these organizations' folders to drill down into the organizational hierarchy. You can click the name of an organization to display the Organization Details page for that organization.

Users in the Managed Organizations hierarchy are displayed in the same way as in the Direct Reports section.

Summary information in the My Territory section of the home page

In addition to the common command buttons, the following information is shown in the Territory section of the home page.

The following table shows the summary information in the My Territory section of the home page:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the user.</td>
</tr>
<tr>
<td>Organization</td>
<td>The organization to which this user belongs.</td>
</tr>
<tr>
<td>Title</td>
<td>The title that is specified for the user when the user was added to the system.</td>
</tr>
<tr>
<td>Role</td>
<td>The role that is assigned to the user when the user was added to the system.</td>
</tr>
</tbody>
</table>

View territory command button for Territories

The following table shows the View territory command button along with its description:
### Organizations section of the home page

The Organizations section of the home page lists the organizations that employ the users in your system. The organizations are defined by an administrator on the Organization Details page, and users are assigned to an organization when they are added to the system.

The organizations can represent divisions in your sales and marketing force, company departments that are involved in your sales or marketing activities, external companies that employ partners or resellers, or any grouping of users that reflects your business model. With this view, you can easily see and explore the hierarchical relationship of the organizations.

### Summary information in the Organizations section of the home page

When the tree details are displayed, the following columns of information are listed for each top-level organization:

**Table 20. Column name and description**

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name given the Organization when it was created.</td>
</tr>
<tr>
<td>Default Leadbox</td>
<td>The user in this organization that receives leads sent to the organization if no routing rules can be applied to direct it to another user. This user is specified when the organization is created and can be changed on the Organization Details page.</td>
</tr>
<tr>
<td>Organization Type</td>
<td>The type of organization as specified when the organization was created. The following organization types that can be specified.</td>
</tr>
<tr>
<td></td>
<td>• Direct Sales Force</td>
</tr>
<tr>
<td></td>
<td>• Distributor</td>
</tr>
<tr>
<td></td>
<td>• Integrator</td>
</tr>
<tr>
<td></td>
<td>• Reseller</td>
</tr>
<tr>
<td></td>
<td>• Value added reseller</td>
</tr>
<tr>
<td></td>
<td>Your system might have different options.</td>
</tr>
</tbody>
</table>

### View direct reports command button for Organizations

The following table shows View direct reports command button along with its description:

**Table 19. View territory command button**

<table>
<thead>
<tr>
<th>Button Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>You can click View territory for selected user to view the reporting hierarchy for a selected user in a pop-up window. The hierarchy is reduced to the direct reports and managed organizations for the selected user. So, you can focus in on one portion of the reporting hierarchy.</td>
</tr>
</tbody>
</table>
Table 21. View direct reports command button

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Click View direct reports to view all the users that work for the selected organization.</td>
</tr>
</tbody>
</table>

Referrals section of the Home page

Referrals section on the home page consists of command buttons with which you can initiate and complete various tasks such as opening referral message page, viewing history of referral, and print the referral leads information.

Referrals section of the Home page contains following information:

Summary information in the Referrals section of the Home page

By default, the following columns of information are listed for each referral.

Table 22. Column name in the Referrals section of the Home page

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Messages</td>
<td>Indicates whether any messages are associated with this referral. A closed envelope in this column means that there is a new, unread message. An open envelope means that there is a message that is already read.</td>
</tr>
<tr>
<td>Opportunity</td>
<td>The name of the referral. The name is automatically generated when you create the referral and includes the referral originator’s organization and name.</td>
</tr>
<tr>
<td>Product</td>
<td>The product or service for which the referral was generated.</td>
</tr>
<tr>
<td>Contact</td>
<td>The name of the customer for whom the referral is being requested.</td>
</tr>
<tr>
<td>Date Entered</td>
<td>The creation date of the referral.</td>
</tr>
<tr>
<td>Date Last Modified</td>
<td>The date when the most recent change was made to the referral. With this date you can track when a message or other information was last added to the referral.</td>
</tr>
<tr>
<td>Assigned To</td>
<td>The name of the person currently responsible for the referral lead.</td>
</tr>
<tr>
<td>Status</td>
<td>The lead status category: Accepted, Closed, Rejected, Waiting, or Up for Grabs.</td>
</tr>
</tbody>
</table>

Command buttons in the Referrals section of the Home page

The following table describes the command buttons that are unique to referrals.

Table 23. Command buttons in the Referrals section of the Home page

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Icon]</td>
<td>Opens the Messages page for the selected referral. You can use this page to review existing messages and to add a new message.</td>
</tr>
<tr>
<td>![Icon]</td>
<td>Displays the Lead History page for the selected referral’s lead. You can use this page to review the actions that are taken on this referral lead.</td>
</tr>
</tbody>
</table>
Table 23. Command buttons in the Referrals section of the Home page (continued)

<table>
<thead>
<tr>
<th>Button</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Button Icon]</td>
<td>Prints the details information for the selected Referral leads.</td>
</tr>
</tbody>
</table>

Change Requests I Initiated section of the home page

Home page consists the **Change Request I initiated** section to check the status of your initiated requests. You can find four types of status: Pending, Approved, Rejected, and Invalidated.

The following table describes the status and their description in the Change Requests I Initiated section.

Table 24. Request status

<table>
<thead>
<tr>
<th>Status</th>
<th>Description</th>
</tr>
</thead>
</table>
| Pending  | The change request is submitted to the approver. You can do the following.  
  - Delete the request  
  - Add a note to the request |
| Approved | The change request was approved by the approver, and the associated table is updated. |
| Rejected | The change request was returned to you by the approver. The associated table was not changed. You can do the following.  
  - Delete the request  
  - Modify the request and resubmit |
| Invalidated | The change request cannot be approved because the structure of the associated table was changed outside of the change request process. You can do the following.  
  - View the request  
  - Delete the request |
Before you contact IBM technical support

If you encounter a problem that you cannot resolve by consulting the documentation, your company’s designated support contact can log a call with IBM technical support. Use these guidelines to ensure that your problem is resolved efficiently and successfully.

If you are not a designated support contact at your company, contact your IBM administrator for information.

**Information to gather**

Before you contact IBM technical support, gather the following information:

- A brief description of the nature of your issue.
- Detailed error messages that you see when the issue occurs.
- Detailed steps to reproduce the issue.
- Related log files, session files, configuration files, and data files.
- Information about your product and system environment, which you can obtain as described in “System information.”

**System information**

When you call IBM technical support, you might be asked to provide information about your environment.

If your problem does not prevent you from logging in, much of this information is available on the About page, which provides information about your installed IBM applications.

You can access the About page by selecting Help > About. If the About page is not accessible, check for a version.txt file that is located under the installation directory for your application.

**Contact information for IBM technical support**

For ways to contact IBM technical support, see the IBM Product Technical Support website: (http://www.ibm.com/support/entry/portal/open_service_request).

**Note:** To enter a support request, you must log in with an IBM account. This account must be linked to your IBM customer number. To learn more about associating your account with your IBM customer number, see Support Resources > Entitled Software Support on the Support Portal.
Notices

This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information about the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user’s responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

Intellectual Property Licensing
Legal and Intellectual Property Law
IBM Japan, Ltd.
19-21, Nihonbashi-Hakozakicho, Chuo-ku
Tokyo 103-8510, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law: INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM websites are provided for convenience only and do not in any manner serve as an endorsement of those websites. The materials at those websites are not part of the materials for this IBM product and use of those websites is at your own risk.
IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
170 Tracer Lane
Waltham, MA 02451
U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Any performance data contained herein was determined in a controlled environment. Therefore, the results obtained in other operating environments may vary significantly. Some measurements may have been made on development-level systems and there is no guarantee that these measurements will be the same on generally available systems. Furthermore, some measurements may have been estimated through extrapolation. Actual results may vary. Users of this document should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM’s future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

All IBM prices shown are IBM’s suggested retail prices, are current and are subject to change without notice. Dealer prices may vary.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which illustrate programming techniques on various operating platforms. You may copy, modify, and distribute these sample programs in any form without payment to IBM, for the purposes of developing, using, marketing or distributing application programs conforming to the application programming interface for the operating platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or imply reliability, serviceability, or function of these programs. The sample programs are provided "AS IS", without warranty of any kind. IBM shall not be liable for any damages arising out of your use of the sample programs.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

---

**Trademarks**

IBM, the IBM logo, and ibm.com® are trademarks or registered trademarks of International Business Machines Corp., registered in many jurisdictions worldwide. Other product and service names might be trademarks of IBM or other companies. A current list of IBM trademarks is available on the Web at “Copyright and trademark information” at www.ibm.com/legal/copytrade.shtml.

**Privacy Policy and Terms of Use Considerations**

IBM Software products, including software as a service solutions, ("Software Offerings") may use cookies or other technologies to collect product usage information, to help improve the end user experience, to tailor interactions with the end user or for other purposes. A cookie is a piece of data that a web site can send to your browser, which may then be stored on your computer as a tag that identifies your computer. In many cases, no personal information is collected by these cookies. If a Software Offering you are using enables you to collect personal information through cookies and similar technologies, we inform you about the specifics below.

Depending upon the configurations deployed, this Software Offering may use session and persistent cookies that collect each user’s user name, and other personal information for purposes of session management, enhanced user usability, or other usage tracking or functional purposes. These cookies can be disabled, but disabling them will also eliminate the functionality they enable.

Various jurisdictions regulate the collection of personal information through cookies and similar technologies. If the configurations deployed for this Software Offering provide you as customer the ability to collect personal information from end users via cookies and other technologies, you should seek your own legal advice about any laws applicable to such data collection, including any requirements for providing notice and consent where appropriate.

IBM requires that Clients (1) provide a clear and conspicuous link to Customer’s website terms of use (e.g. privacy policy) which includes a link to IBM’s and Client’s data collection and use practices, (2) notify that cookies and clear gifs/web beacons are being placed on the visitor’s computer by IBM on the Client’s behalf along with an explanation of the purpose of such technology, and (3) to the extent required by law, obtain consent from website visitors prior to the placement of cookies and clear gifs/web beacons placed by Client or IBM on Client’s behalf on website visitor’s devices.

For more information about the use of various technologies, including cookies, for these purposes, See IBM’s Online Privacy Statement at: http://www.ibm.com/privacy/details/us/en section entitled “Cookies, Web Beacons and Other Technologies.”